
         
 

 

HOW TO STUDY DynEd 
 

 
DynEd courseware is designed to help you acquire the target language in a natural 
but accelerated mode of learning.  It represents a significant advance over traditional 
English language learning materials.  As with any new set of tools, however, teachers 
and students alike need to develop techniques and strategies for using it most 
effectively. This Study Guide offers suggestions for how to study most effectively. 

     

NEUROSCIENTIFIC BACKGROUND 
 
 Learning involves changes in your brain. 

Electrochemical changes and new connections 
between neurons must occur for learning to take 
place.  Just as when you are working on your 
computer, if you don’t save your work it will be lost.  
Saving data in the brain involves changes in the brain.  
Some of these changes happen quickly, and some of 
these changes happen over a period of days or weeks. 

 

What is Language 
Learning? 
 

          
 

 
 

Language Learning is Skill 
Development 
 
 

 

 
 
Learning a language is like learning how to play a 
musical instrument.  Frequent and effective practice is 
the key.  The skills of listening and speaking, in 
particular, require speed.  When you listen or speak, 
you have very little time to process the language, 
much less time than when you read a text.  There is no 
time to ‘remember’ a word or rule.  It must be 
automatic.  To develop this automatic ability, practice 
and repetition are essential, and without using text as 
a support.                                              
 



Best Study Practices 

 
There are different types of memory.  Some things you 
remember just long enough to accomplish a short-term 
task, such as repeating a list of words or sentences, 
and then it is forgotten.  Many language students study 
vocabulary words and sentences and memorize them.  
However, without repeated use of the words and 
sentences over a period of time, this kind of learning 
quickly fades.  Research shows that long term memory 
takes time to develop.  Short, frequent sessions over a 
period of several days or weeks are the best way to 
study and develop your language skills.  Constant 
review should also be part of your practice strategy.  In 
this sense, going slow, with lots of repetition and 
review, is the best way to learn quickly. 

One very important advantage of multimedia study is 
the possibility to activate many parts of your brain at 
once.  A famous neuroscientist said:  “Neurons that 
fire together, wire together.”  After you have studied a 
lesson to the point where your comprehension is good, 
you should begin to practice saying each sentence.  
Use the microphone to record your voice.  Then 
compare what you said with the native speaker model.  
Compare your speed, stress and intonation, and 
pronunciation.  This type of practice activates the 
phonological processor in your brain and helps to 
develop both automaticity and long-term memory.  At 
least part of every study session should include 
several minutes of this very important focused 
practice. 
  
 

 

 

    

What is Memory? 
 

 
 
 
 
 
 
 
 
 
 
The Importance of 
Recording/Playback 
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Best Study Practices 

 
 
Listening and reading use very different pathways in 
the brain.  The best way to develop listening and 
speaking skills is to not rely on text.  Using text as a 
support interferes with the development of listening 
and speaking skills, which need to be developed first.  
When studying a lesson, try not to use the text support 
until after you have developed your ability to 
understand and repeat the key sentences.  Research 
indicates that using the text support too soon slows 
down your listening and speaking development – even 
though most students think that using the text is an 
effective way to learn.  It may be comfortable, but it 
isn’t effective. 

 
 

Studies of the brain and long-term memory formation 
show that repetition is very important to skill 
development.  Listening and speaking abilities are 
skills, not knowledge.  Skill development requires 
effective practice, and this practice must be done on a 
regular, frequent basis.  To develop listening and 
speaking skills, you must be able to decode language 
automatically, without thinking or memorizing.  Your 
brain is designed to do this, but only if you practice, 
practice, practice!  Good luck. 

  
 

The Danger of Using Text 
Support 
 

 
 
 
 
 
 
 
 
The Importance of Practice 
 
 

 
 
 
 
 
 
How to Reduce Study Time 
 

 

Research shows that regular, frequent study 
sessions reduce total learning time.  Studying and 
reviewing parts of a lesson several times a week 
is more effective than studying just once or twice a 
week.  Three 45-minute study sessions are more 
effective than one three-hour session.  Study 
sessions that are too long are generally inefficient 
and counterproductive. 
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 BEST STUDY PRACTICES 
 

The most effective study sessions are a mix of 
activities and lessons.  Spending too much time on an 
activity or lesson in a single study session creates 
boredom and inattention.  You need to be focused.  
Generally, most students should change activities or 
lessons several times in a study session.  In some 
lessons, focus on listening comprehension. In other 
lessons, focus on speaking practice.  Some lessons 
should be done every day until you have mastered 
them or can summarize the entire lesson without any 
effort.  This develops confidence and automaticity. 

What about that Unit you studied 3 weeks ago?  Is 
it finished? 
 
No, it isn’t finished.  You should review it and be 
prepared to use that language at any time.  Your 
teacher should ask you to review it often, and class 
activities should assume you can understand and 
express the information modeled in that unit even 2 
weeks from now.  It isn’t going backward – it’s going 
forward by building a real skill!  In this sense, going 
backward can help you go ahead even faster!  
 

 

 

 
 
Effective Study Sessions 
 
 

 
 
 
 

Progress and Review 
 

 
     
 

Learning a language isn’t learning one thing and then 
going on to another.  It’s building on what you know 
and using it all, in an expanding spiral. 
 
 

Slow is Fast The biggest mistake learners make is trying to finish 
each lesson quickly.  This fails to build the foundation 
and confidence necessary to improve listening and 
speaking skills.  If you go through each lesson several 
times on many different days, practice speaking, and 
review often, your overall progress will be much faster 
and your test scores will improve.  If you don’t do this, 
you will quickly forget what you have learned.  The  



Best Study Practices 

 
 
old-fashioned way of studying is slow and 
ineffective.  Remember:  Practice Makes Perfect. 
 
 
Once you understand a lesson, you should go 
through it and practice speaking the sentences.  
Record 5 or 10 sentences in each study session 
and compare your recording with the native 
speaker model.  This kind of intensive practice will 
help you master the language and build your 
fluency.  If you don’t do this, your speech will be 
slow and halting.  Please practice each lesson 
until you can say the sentences quickly and with 
confidence. 
 
 
Yes, repeating things can be boring.  But how can 
you learn a new skill without practicing?  It 
requires discipline and determination.  If you 
practice effectively, you will be able to listen and 
speak with ease, building from simple 
communication to complex communication.  This 
takes time.  But the more you practice, the less 
time it will take.   

To make practice more interesting, try to use the 
new language to express things about your own 
life, job, or interests.  The language models in 
DynEd courseware are very general.  If you 
master them, they will help you communicate 
 

 
 
Understanding is Only the 
Beginning 
 

 
 
 

Practice  is  Boring 
 
 
 
 

     
 
 
 

about yourself – and doing this will improve your 
vocabulary.  Reading and writing exercises that 
extend the topics and themes of this courseware 
are effective ways to increase your vocabulary. 
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Best Study Practices 

 
 
If your speech is slow and halting in class, it’s 
because you haven’t yet mastered the language in 
the lessons.  Go back, review, and practice saying 
the sentences every day.  Then you’ll speak with 
more confidence in class.  If your oral presentation 
was good, but slow and halting, do it again in 
another week.  Make it better.  It isn’t going 
backwards.  It’s the way to go forward. 

 

Language learning is most effective if you begin 
with listening, move to speaking, then extend the 
language by reading and writing, each time adding 
new vocabulary.  These skills reinforce each 
other. 

 

My Speech is Slow and 
Halting 
 

      
 
 
 

The 4-Skills Path 
 
  
 
 
 
 
 

Personalization and 
Extension of the Language 
 

 
 
 
 

 
The language models in the courseware are very 
general.  They provide a framework for English that is 
very powerful and should be mastered.  As you learn 
and master the language in the courseware, it is 
important to transfer and extend it to your own life and 
situation.  This will give the language life and make it 
more interesting to you.  Classroom activities should 
help you do this.  Exchange information with other 
students.  This is also where you will learn new 
vocabulary and useful expressions that will add to the 
framework presented in the courseware.  The course, 
the classroom, and your life need to work together. 
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Best Study Practices 

 
The conceptual underpinnings and grammar of English 
are like the trunk and branches of a tree.  The 
vocabulary and expressions are like the leaves on the 
tree.  As the branches are exercised, they become 
‘sticky’ and new vocabulary items have a place to go.  
Without the branches, the leaves are easily forgotten 
and drop away, just as a file on a computer which has 
a disorganized file structure can be difficult to find.  
Language items must be properly tagged in order to 
be remembered quickly.  Mastering the language 
models in DynEd courses, along with classroom 
support, will support new vocabulary and lead to long-
term learning at a much faster rate than traditional 
approaches.  Memorizing lists of vocabulary words 
and idioms is generally an inefficient way to learn a 
language – though this is the traditional method that 
many people expect to use – and it’s one reason why 
learning a language takes so much time. 

 

 Language Models 

 
 

 
 
      

Optimum Placement Level 
 
 

 
 

 

 
After taking your Placement Test you will be placed in 
lessons so that you are at an optimal learning level.  
This means that the material will not be too difficult or 
too easy.  What you know will help you guess or fill-in 
what you don’t know.  You should try to guess the 
meaning of unfamiliar words and grammatical patterns 
without using text.  If you cannot do this, you have 
been placed at a level that is too high.  If you are 
placed at the right level, you should also review 
material from lower units to confirm your level and to 
reinforce what you already know.  Please remember 
that mastery and automaticity are your goals – not just 
comprehension.  Understanding is not enough.  
Operational ability means automaticity.  This is true for 
most skills, and is especially important for listening and 
speaking skills.  The result will be to develop your 
confidence to use English. 
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STUDENT PRACTICE SUMMARY 

Effective and frequent practice is the key to language learning.  Short, 
frequent sessions are generally more effective than longer, infrequent 
sessions, because fatigue and other factors lead to inattention.  More 
frequent study reduces the total time required to move from one language 
level to another.  Ideally, students should use the program on a daily basis, 
in 25~45 minute sessions, and meet with a class and/or teacher once or 
twice per week.  This model is similar to how students learn to play a 
musical instrument: Periodic meetings with a teacher or group, supported by 
daily practice sessions. 
 
The amount of time and effort required to complete a particular lesson 
depends on level, language background, and whether the course is used as 
the main course or as a course supplement.  Students should go through 
each lesson in the following ways: 

(1) Preview; where they gain an overview of the lesson and general meaning 
without using the text; 

(2) Comprehension, where they understand the content in increasing detail 
and confidence, repeating each sentence as many times as is necessary; 

(3) Language Focus, where they check the text and glossary entries as 
needed.  At this stage, students focus on the grammar and structure of the 
sentences., as well as new vocabulary; 

(4) Language Practice, where they say each sentence or word, record it and 
compare it with the model; 

(5) Review, where they regularly go over the languages that they have 
previously practiced; 

(6) Intermittent Review, where they periodically return to the lesson to confirm 
their mastery of the material. 

 
In one study session, students should work on parts of several lessons, and 
not be restricted to just one lesson (see Learning Path).  It is better to work 
through a lesson in a series of shorter sessions spread out over several 
days than spend a large amount of time in a single study session. 

Note:  To improve listening skills, students should not rely on text too early. 
When the text is visible, the listening process is completely different.  
Students should not look at the text until after they have listened to the 
language several times.  If the material is too difficult to be used in this way, 
they should work with less advanced material or review previous Units. 
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THE COMPLETION PERCENTAGE 

 
The Completion Percentage is shown in the Student Records. It is 
also shown by meter icons that show under the Unit 
buttons when the mouse moves over the Student Records meter icon 
on the main menu screen.  This indicates how effectively the student 
has studied and practiced each lesson.  For more detailed 
information, please see the Records Manager Guide.  In general, 
students should attain an 80-85% Completion Percentage in each 
lesson.  This will ensure that they are going through each lesson 
several times, repeating and recording sentences, and moving from 
comprehension and practice to mastery.  These steps lead to 
acquisition and long-term learning. 
 
To assist students in reaching the goal of communicative competence, 
the Completion Percentage sets study goals based on the following 
study activities:  sentence repetitions, voice recording attempts,  
speech recognition activity, use of the glossary, shuffler level, and the 
number of questions which are answered correctly. 
 
 

INTELLIGENT  TUTOR 
 

Many students feel ready to stop an activity when they ‘understand’ it.  
However, effective language learning should be approached as a skill to 
be acquired, and not merely an ‘understanding’ of grammar rules and 
vocabulary. The development of communicative competence and 
language automaticity requires regular focused practice through a cycle of 
preview, comprehension, practice, and review – and this over an extended 
period of time. 
 
DynEd’s Intelligent Tutor analyzes the study data for each student and 
class, including Completion Percentages, study frequency, test score 
levels, and usage of features such as voice record, and makes 
recommendations for improving study practices.  It also looks for 
negative study patterns, such as inappropriate use of text support when 
developing listening comprehension. This feature is a real time-saver 

 9



 

 
for teachers and should be consulted on a regular basis. 

 
A new feature of the Intelligent Tutor is to assign a Study Score to each 
student, from very poor to excellent, in a range from -12 to +12 -- though 
the range depends on the course being studied. 

Excellent  +5  +12 A 

Good study +2 +4 B 

Fair study -1 +1 C 

Poor study -4 -2 D 

Very poor -12 -5 F 

Here is an example of a typical tutor message with study score: 
Susan Chao   (Time = 59:11)  First English 
1) good use of repeat button 
2) good Mastery Test score(s) 
3) good study frequency in the last two weeks 
4) good success with comprehension questions 
5) good study time in the last 2 weeks 

 Study Score = 9 
Teachers now have the option of allowing students to see their Study 
Scores in the Study Records.  For more information about the Intelligent 
Tutor, please consult the Records Manager Guide. 
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USING THE COURSEWARE 
DynEd’s courseware has been designed for ease of use by students and teachers.  
Nevertheless, before students begin to study on their own, it is important to introduce the 
basic functions of the program and to give suggestions about how best to study.  For 
additional information, please consult the User’s Guide. 
 

 
The DynEd Control Bar 
 

 

The Control Bar appears at the bottom of the 
screen in each lesson and allows students to:  
• Exit from a lesson 
• Pause the program  
• Record and playback their voices   
• Repeat individual words and sentences  
• See the written text and access the 

Glossary. 

Learners use the Control Bar  to control the 
pace and focus of their learning experience. 
When first using the program, click the buttons 
and explore their functions. Here is a description 
of the function of each of the buttons: 
 

When you want to hear something 
again, use the Repeat button.  You 

can listen to each sentence or question as many 
times as you’d like. 
 

Click on the Pause/Play button to stop 
for a short time or if you need time to 

answer a question. When the Pause/Play button 
is flashing green, the program is 
paused and will not go to the next 
sentence. Click the Pause/Play button
order to continue. 

 again in 
hen it is your turn to make a choice 

 you don’t understand an English Whenever you click on any Control Bar button, 
the Pause/Play button will begin to flash and the 
program will pause until you click on the Play 
button again. 
 

To see the spelling of a word or group 
of words, click on the Text button. If 
you click on a highlighted word, you 
will see a Glossary screen. 

 

 

 

The Voice Record button 
lets you record your voice. 
Click it to start recording and again to stop the 
recording. Then click on the Voice Playback 
button to listen to the recording.  You can then 
compare your voice with the model by using the 
Repeat button.  
 
Use the Exit  button to leave a 
lesson at any time.  You can then 
choose another lesson or quit the program 
completely. 
 
The Rewind button allows you to go 
back in the program one frame at a 
time, for example to hear a previous sentence 
 
Use the Fast-Forward button to move 
ahead in a lesson one frame at a time. 
You cannot fast-forward through an exercise or 
comprehension question. The program will 
pause until the question is answered. 
 
W
or to speak, the Timer will begin to 
time down. 
 
If
sentence, click on the Translation 
button (if available). You will see the same 
sentence translated into your own language. 
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Pull Down Menus 
The DynEd pull-down menus are at the top of 
your screen:  Options, Speech Recognition, 
and Help. 

Use the File menu to change from one course to 
another. 

Use the Options menu to:  
• View Student Records 
• Access the Glossary 
• Adjust the volume on your computer 
• Increase or decrease the pause between 

sentences  
Student Records 
The Student Records show the time spent in 
each lesson, the number of study sessions, the 
Completion Percentage, Quiz and Test scores, 
and the Shuffler Levels. Teachers can access 
the Student Records through the Records 
Manager. 

Glossary 
This provides alphabetical access to the 
Glossary screens for this course.  You can also 
access the Glossary through the highlighted text 
whenever it occurs in a lesson. 

Levels 
This allows the user to set or view the levels of 
the following controls: 
 
Volume:  The Volume settings enable the user 
to control the volume of the audio, as well as for 
sound recorded using the Voice Record feature. 
 
Pause Length:  The language of the courseware 
is natural language spoken at a normal pace.  
Students can, however, adjust the amount of 
time between each sentence.  A longer pause 
gives students more time to process the sounds 
they have just heard and to access 
comprehension aids (repeat, translation, text on) 
if necessary.  A shorter pause more closely 
approximates natural speech and provides more 
of a listening challenge. 

 

Speech Recognition 
Help screens for Speech Recognition are 
available through the Speech Recognition pull-
down menu at the top of the screen.  Detailed 
instructions are also available in the Study 
Guides. 

Help Screens 
Use the Help pull-down menu at the top of the 
screen.  For bilingual versions, the Help screens 
are available with native language support. 
 
Changing Courses or Modules  

Go to the File pull-down menu at the top of the 
screen.  Click on Change Course to switch from 
one course to another without having to exit the 
program.  In some courses, such as Let’s Go and 
Dynamic Business English,  you can also change 
Modules or Units by clicking on Change 
Module/Unit. 
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STUDENT LEARNING PATH 
 
Many students feel ready to stop an activity when they understand it.  However, that is 
when real language learning begins.  Language skills such as listening and speaking 
need to be mastered through practice.  
 
Teachers should instruct and coach the students how to go through the lessons, not 
once or twice, but multiple times.  The following learning sequence is recommended:  
 

Preview 

Comprehension 

Focused 
Practice 

Review 

Intermittent 
Review 

1. Preview; where students gain an overview of a lesson and its general meaning without 
using the text; 

2. Comprehension, where students understand the content in increasing detail and repeat 
each sentence as many times as is necessary; 

3. Language Focus, where students check the text and glossary as needed.  At this stage, 
students focus on the grammar and structure of the sentences, as well as new vocabulary; 

4. Language Practice, where students say or paraphrase each sentence, record it and 
compare it with the model.  This is very important to ensure long-term learning. 

5. Review, where students regularly go over the lessons that they have previously practiced; 
6. Intermittent Review, where students periodically return to lessons to confirm their 

mastery of the material. 
 

In addition to effective practice, students need to use their study time so that they are 
fully engaged.  This means breaking up the time into shorter time segments, generally 4-
6 minutes long, and varying the kind of activities they are working on in a study session.  
Students should not, for example, spend 30 minutes previewing one day and then 30 
minutes reviewing another day.  The activities need to alternate in each study session.  
In addition, students shouldn’t spend the entire study period on one lesson, but should 
do several lessons in parallel.  For example, in a 40~50-minute session, students can do 
parts of several lessons or units.   
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